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Novapoint 21
Release date: 09.05.2018
Known Issues
How to migrate models from Novapoint 20 to 21
FAQ regarding upgraded models from Novapoint 20 to 21
Links: Base | Road | Area Planning | Landscape | Terrain Design | Railway | Noise | Bridge Design | Tunnel | Water &
Sewer | District Heating | Road Signs | Road Marking | Land Acquisition Planner | Virtual Map | Reinforcement | Civil
Construction | Feature Catalog 1930 1.25 | Geotechnics | Easy Access |

Updates in Novapoint Base
General

NB! New main version of Novapoint. Models upgraded to or created in this
version cannot be opened in earlier versions of Novapoint. Please read this page
regarding upgrading models.

IMPROVED: This update contains general bug fixes and improvements
IMPROVED: Feature Catalogue
In general, we reduce the number of feature types and increase the use of properties. This is in line with, for
example, buildingSMART and IFC. All feature type definitions are extended with attributes for registering which
application created them, and which discipline it belongs to.
All feature type definitions have been updated with properties for network location.
IMPROVED: The size of a local Quadri workset cache previously had a limit of 8GB. The removal of this means that
Novapoint can now handle much larger Quadri models.
IMPROVED: Default drawing rule is improved and updated according to the new feature types. It includes better
textures, also in section windows. In 3D window it also includes moving clouds and water (for surfaces of
FeatureType WaterBody) and improved rendering of trees. Trees that are imported are automatically rendered,
with botanical names. The Default drawing rule is divided Lifecycle status attribute Existing or Proposed. When this
feature attribute is set, the feature is drawn by the following rule.
Here is a video of improved section windows with solid geometry:
The Adobe Flash Plugin is needed to display this content.
Here is a video example of forest areas:
The Adobe Flash Plugin is needed to display this content.
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IMPROVED: Sky and horizon renderhandler
The Sky and horizon renderhandler in 3D window have been updated with animated clouds. The clouds move
smoothly when user is navigating in the 3D window. User can also click C to get a continuous moving of clouds.
See video with example here:
The Adobe Flash Plugin is needed to display this content.
NEW: Waterbody renderhandler for 3D window
New Waterbody renderhandler is added which enables possibility to get a more realistic rendering of ocean and
water. It is recommended used only on larger water surfaces
See video with example here:
The Adobe Flash Plugin is needed to display this content.
IMPROVED: Dynamic Query
Users can now make both Global filter and Feature Type filter on Generic attribute/Named values. This will make it
easier to get/collect/classify features by querying property information.
See video of how the functionality works here:
The Adobe Flash Plugin is needed to display this content.
Location queries may now use alignments/links to limit a query with to-from section. This is especially relevant for
export tasks, where road & rail models can be reduced to a defined section, e.g. when exporting to LandXML.
See video of how the functionality works here:
The Adobe Flash Plugin is needed to display this content.

Explorer
NEW: In Explorer context menu for Workset/Model, a new functionality Show All Tasks of Type is added:

See video of how the functionality works here:
The Adobe Flash Plugin is needed to display this content.
NEW: In Explorer context menu for Tasks with results/Features, it is now possible to view result in Table view:

Table View is described later in Release Notes.
NEW: For all tasks that include conversion rules
Conversion rules on a tasks can easily be reused through copy and paste functionality:

See video of how the functionality works here:
The Adobe Flash Plugin is needed to display this content.
NEW: Network Elements are added to the Model and can be viewed in Explorer. This is new for the Novapoint
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Design tools. All alignments created will automatically create a Link Sequence and road/railway/utilities features
will be automatically connected to the Corresponding Link.

N > Options
CHANGED: in Windows, default drawing rule for 3D and section windows are in this version set to the drawing rule
named Default.

Home
IMPROVED: Home > Trimble Quadri > Share
We have added information about amount of data (Mb) you are about to share; in total, for each object and for
each task. This will help you detect if you are about to share excessive amounts of data to the centrally Quadri
shared model. Check which features/tasks that are causing issues, and investigate them - before you share.

Insert
IMPROVED: Insert > Import > Import Files
Conversion rules have been improved for many file formats to support the new road/railway/utilities features and
importing alignments will create Link Sequences. IFC and GML import are improved.
NEW: Insert > Process > Project Rules
Project Rule task is a a possibility to add conversion & presentation rules, task templates and layer mapping to a
project. These rules and templates are stored in the model and also shared with the model for Trimble Quadri
models. All places where users select conversion rules, presentation rules, etc. will also allow project rules to be
selected. Read more about Project Rule task here
See video of how to use the new tool here:
The Adobe Flash Plugin is needed to display this content.
NEW: Insert > Sketchup > SketchUp (BETA)
It is now possible to work with georeferenced features in SketchUp through Novapoint. By exporting data from
Novapoint to SketchUp, it is possible to sketch features and import these back to Novapoint. User can select to
work in Sketchup Free/Shop or Pro. Read more (reference guide) here

Modelling
IMPROVED: Sweep and Extrude
The volume of the solid generated geometry by the Sweep and Extrude tools are calculated and added as property
to the result features. This can be reported again as volume values in Table View.
Watch the video here for an example:
The Adobe Flash Plugin is needed to display this content.
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IMPROVED: Existing situation > Move Vertically
Move Vertically have been improved and new functionality to use prioritization for calculation base is. introduced.
Settings button in added to task and user can also add generic attributes to result feature. In TIN priority, user can
give priority to the indata in Calculation Basic. User first have to select Calculation Base, then rearrange Priority in
Settings > TIN Priority if wanted.
Watch this video to see example of how to use Priority in Calculation base:
The Adobe Flash Plugin is needed to display this content.
NEW: New Situation > Intersection
New functionality for creating intersections based on alignments is implemented and improved based on solutions
already available in Trimble Business Center and Trimble Tekla.
This function gives the users an opportunity to quickly create T-/X-intersections or Roundabouts from two or more
alignments. Input is parametric from a dialog and produces 3D results to the Quadrimodel in addition to alignments
for all the surface edges.
The Intersection task does not require the user to have a license for Novapoint Road to work, but requires a
separate installation found on our webpages together with the download files for Novapoint.
NEW: New Situation > Waterways
Module to create Waterways. Developed in collaboration with Finnish and Norwegian Coastal Administrations. It
requires a licence to use this tool. Main features:
●

●

●

●

●

●

●

Professional alignment design
Design ship dimension
Channel geometry tools
Quantity reports and setting out digital data
Elevation tools
Squat prediction analysis
International aids to marine navigation library

IMPROVED: New Situation > Terrain Shaping
In this version there have been minor bugfixing and enhanced stability.
NEW: New Situation > Create Volumes
This new tool makes it possible to calculate volume between two surfaces in Novapoint Base. The function has
been completely rebuilt from ground up, and is now ready for the future.
See video of how to use the new tool here:
The Adobe Flash Plugin is needed to display this content.
IMPROVED: New Situation > Draw Object
It is now possible to draw and edit features also in the section windows (not only in plan and 3D windows.) This is
especially important for geotechnians who want to add interpreted points and lines to sub surface models, and to
complement data created from the import of GeoSuite databases.
Watch this video to see example of use:
The Adobe Flash Plugin is needed to display this content.
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View
NEW: Panes > Feature Extent
As a concequence of introducing transport networks, we launch a new view pane to view what features are
connected to a selected Link.
Watch this video to see example of how to use the Feature Extent Pane:
The Adobe Flash Plugin is needed to display this content.
NEW: Presentations > Table
This is a new type to presentation view type. It is used to present information from the model in columns and rows,
for better understanding model content, task result, quantity takeoff, etc. With the Table Presentation tool, it is
possible to create Table presentation tasks in the model. It is also possible to create temporary tables by selecting
tasks/features in Explorer and select View in Table in context menu.
Watch this video to see how to use Table view:
The Adobe Flash Plugin is needed to display this content.
IMPROVED: Presentations > Drawing rule editor
Drawing rule editor is improved with minor bug fixesto new rule node parameters: SystemNode and Enable in
PresentationSetup
See Drawing rule editor User Guide for more description.

Output
NEW/IMPROVED: Export > Export to File
We have done a lot with Novapoint Base' capabilities to export data for stakeout purposes. Especially to LandXML,
where you can also limit a corridor by using from-to along the Alignment/Link.
See example of how to use stake out in Export files here:
The Adobe Flash Plugin is needed to display this content.
NEW: Publish to > HoloLens
Publish to HoloLens let you export Novapoint data to HoloLens in one SKP file. Read more (reference guide) here

Updates in Novapoint Road
NEW: ALIGNMENT TASK
The Alignment task now requires you to decide what discipline to use the alignment task for.
In the drop-down list for the task templates you will find multiple disiplines to choose from and select here 'Road
Alignment' if the alignment task is to be used as reference alignment for a road task. Alignment tasks intended for
use as reference alignments will also be created with Network Elements.
If the Alignment task is to be used as a boundary alignment only for the different surface descriptions, then use the
template for 'Non-Alignment Line'. This Alignment task will be created without Network Elements.
Novapoint Resource Center - http://resourcecenter.novapoint.com/doku.php?id=en:np:release_notes:np21:np21:start
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More about news for the Alignment Task can be found here.

NEW: NEED TO UPGRADE TASKS CREATED BEFORE NOVAPOINT 21
When working with alignment, road, railway and W&S tasks created before Novapoint 21 there is a need to
upgrade these before continuing with your work.
●

●

Alignment task: Edit task and set the correct template to use to define if it is a reference alignment with network
elements or not. Press Finish to complete the upgrade.
Road task: Edit task and press Finish to complete the upgrade.

Preceding tasks needs to be upgraded before upgrading the active task.

NEW: 64-BIT CODING
The road, railway and W&S cross-section calculation and code has collectively undergone a massive upgrade and
modernization and is now a 64-bit code. Over time this will give the modules an advantage with regards to future
development and functions.

NEW: SOLIDS
Roadmodels produces SOLID features to the Quadrimodel with every build. Solids are created for pavement layers,
cut and fill layers. Also roundings are now shown in 3D as a SOLID.
The properties of the SOLID also shows the volum values that they represent in the geometry attributes.

The SOLID features also makes it possible to show hatched surfaces when viewing the road task as part of a Long
Section or Cross-section task.

NEW: RESULT FEATURES IN FEATURE CATALOGUE
There are some new features produced by the road task in comparison to what was produced in Novapoint 20.
Road Top Surfaces:
These remain the same as before.
StructureLayer:
The pavement layers are now called StructureLayer and the same feature is used for all the pavement layers in
addition to the inner slope surface. The feature is a multi-geometry feature that can hold both geometries for solids
and surfaces in the same object.
Separation between the different pavement layers are done in the properties based on attributes for:
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layerDescription/designation: Denotes what type of sub-layer it is (wearing, binder, base, sub-base, filter)
layerDescription/keyIdentifier: Denotes what number in the sub-layer it is, f.ex. Binder course 2
layerDescription/name: Is a fullname given the object saying what it is, f.ex. PAVEMENT_BINDER_COURSE_2

Cut:
All cuts of TopSoil, Vegetation, SoftSoil, Soil and Rock are created as this feature. The cut features are produced as
solids only. Separation between the different cuts are done through the attribute for
earthenMaterial/civilEngineeringClassification.
FillLayer:
For all fills they are created as the feature FillLayer. Separation between the different types of fill can be found in
the attributes for FillPurpose and detailedVolumeDescription.
Subgrade:
Compared to earlier versions this replaces the Formation-surface.
The roadbed is placed on this feature type and is also split in multiple surfaces denoting if it is in rockcut/soilcut or
on a fill.
Outside of the roadbed the Subgrade surface is a generic surface going out to the edges of the road model.
LowestConstructionWorkSurface:
This feature shows the lowest surface of all the results of the roadtask.

NEW: TABLE VIEW ON TASK
Right-clicking on a road task and selecting 'View in Table' will show all the result objects in a Table View. To do
further changes to the Table View choose to 'Save as task'. More information on the functionality can be found
here.

IMPROVED: DEFAULT DRAWING RULE
The Default drawing rule is updated and improved in many ways. More information here.
For Road this means:
●

●

●

●

●

More use of texturing information found in the TextureName attribute
Separation between Road and Railway results
Solids from the road model are textured
Contourlines on all of the roads top surfaces
Water run off arrows on all of the roads top surfaces

NEW: CLEAN-UP OF SELF-OVERLAPPING OBJECTS
In the cases where the road model results are self-overlapping and in effect goes backwards compared to the
previous cross-sections, then the model cleans up the results so it does not overlap.
The clean-up makes the end results for the quantity calculations more correct as the solids cannot self-overlap.

NEW: COPY CONVERSION RULES BETWEEN SAME TASK TYPES
Novapoint Resource Center - http://resourcecenter.novapoint.com/doku.php?id=en:np:release_notes:np21:np21:start
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To minimize the need to work in the Quadrimodel files in the File Explorer in Windows it is now possible to
right-click a road task and copy the conversion rules file. Go to the desired road task to paste it there. Note that
this requires that the receiving task is not in a non-reserved state.

NEW: INTERSECTION TASK
This is a new functionality for creating intersections in an instant based on alignments. The tool is implemented
and improved based on solutions already available in Trimble Business Center and Trimble Tekla.
This function gives the users an opportunity to quickly create T-/X-intersections or Roundabouts from two or more
alignments. To adjust the intersections the input is parametric through a dialog. The function produces 3D results
as surfaces to the Quadrimodel in addition to alignment tasks for all the surface edges.
The Intersection task requires a separate installation found on our webpages together with the download files for
Novapoint.
Here is a PDF for a quick introduction in how to use the Intersection task.
The separate install file can be downloaded from this link.

CHANGED: REPLACING *.GEN AND *.IND FILE FORMATS
With the change from 32-bit to 64-bit there is a need for new file formats to handle the data.
●

●

DMI/DMR files are the indata and result files of the road design model. They replace the 'GEN-files' (previously 6
files).
PARAM file replaces the IND-file. It is an XML-file that is better for storing bigger data.

*.GEN and *.IND can still be used in Novapoint 21 when creating a road task, but it is not possible to store to these
formats to use in older versions of Novapoint (NP20 and older).

REMOVED: EXTERNAL MODELS FUNCTION
The functionality to add other roadmodels as external models to the active design model is no longer available.
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Instead use illustration objects. More on this matter in the chapter about Cross-section Viewer.

REMOVED: SETTING OUT DATA FUNCTION
The Setting Out Data function found in the road model is no longer available. Exporting data is now to be done
directly from the Novapoint Base > Output > Export to file.

IMPROVED: 3D RESULTS
There is now in use a new engine to produce the 3D results from the road model calculations. 3D results should
now be better than before.
FIXED: Big spikes going back to the left-most point of the first calculated chainage.
FIXED: Roadbed taking a shortcut in some cases because of issues with filtering of data to produce results from.

FIXED: Inner slope surface error when used in combination with Embankment Ditch in certain combinations. Inner
slope surface shoots up to road surface at the top of the embankment.

CROSS-SECTION VIEWER
NEW: Right-click on active roadmodel gives access to all the functions found in Design-tab of the Road task.
Right-click also gives access to the cross-section calculation 'Errors and Warnings'-report file.
NEW: Right-click on illustration objects from Road or Railway tasks gives access to all the functions found in
Design-tab this task. Right-click also gives access to the cross-section calculation 'Errors and Warnings'-report file.
NEW: Build illustration objects from Road or Railway tasks in the Cross-section viewer through the right-click menu.

To see the changes when building a model as an illustration object you also
need to rebuild the cross-sections for the active road model.

NEW: Text in lower left corner of the Cross-section Viewer window
●

●

Shows what type of changes in the model that triggers the cross-section to be build
Shows the error or warning message relevant for the cross-section

These can be toggled ON/OFF in the Layer-dialog.
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BUILD PROCESS
When building a road task we have done changes to make all the different build sequences (different buttons in
the software) act more in the same way.
IMPROVED: Building road task with 'Update Dynamic Alignments' is faster than before as it does not create 3D
results twice.
CHANGED: The dialog showing the old steps for road model calculations does not show any longer as it is not in
line with the build order when building from road task ribbon in Novapoint Base. The information and build steps
are shown in the Process Info in Novapoint Base as before.

CHANGED: The 'Error and Warnings report'-button no longer shows as the old build dialog is not available. Error
and warnings can be viewed with every build in the Process Info in Novapoint Base.
To get the old 'Error and Warnings'-report it is still available:
●

●

Right-click on the cross-sections in the Cross-section Viewer
Working from the old tool it is also available through the menu View > Error and Warnings.

IMPROVED: Maximum number of cross-sections to calculate is increased to 30'000 (from 10'000). NOTE:
Calculation time increases also.

ROAD SURFACE DESCRIPTION
NEW/IMPROVED: Numbering of the road surfaces has changes from f.ex. 1.1 and reads now as 1.01.
NEW: There are now 19 subsurfaces in each surface group (0-7).
NEW: Right-click to insert new subsurfaces in the surface group shows information about the destination feature
set in the conversion rule file. The solution is dynamic and reads directly from the conversion rule file. This
simplifies the process in using the correct surface.

NEW: Right-clicking the subsurface gives option to 'Save/Delete surface edge as alignment'. This also makes it
possible to 'Save/delete surface edge as alignment' for the road/railway task as illustration objects.
CHANGED: 'Save surface edge as alignment' gives the user option to save it as a Reference Alignment task or not.
The difference is that a Reference Alignment task is possible to use as a reference alignment for a road task.
NEW: Right-clicking the 'Left' or 'Right' in Road surface description gives option to 'Save/Delete model edges as
alignment'.
IMPROVED: Naming of the dynamic alignment task is improved to have better order in the model. The name of the
road task and the surface number has changed places and now shows: P_#TaskName#_#SurfaceNumber#
●

●

Old naming: P_-3.3_Road 2
New naming: P_Road 2_-3.3

PAVEMENT DESCRIPTION
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NEW: There are now 10 pavement layers available in the road model. The two new additions (from previous 8
layers) are 'Base course 3' and 'Sub-base course 3'.

Rehabilitation
IMPROVED/FIXED: Rewrite of the code has fixed minor issues in the cross-section calculations.
FIXED: Additional scarifying did not always work correctly.

MINIMUM DITCH DEPTH
IMPROVED: Punctuation, now you can use both 'comma (,)' and 'period (.)'.

ALIGNMENT DESIGN
NEW: Magic Wand tool to fix issues where radius is to big and solution is NOT OK.

Updates in Novapoint Water and Sewer
Updates in Novapoint Road Sign
Belgian version
●

NEW: New signs - Added support for ZE3 and ZE3b (#HAN-804)

Finnish version
●

●

●

●

NEW: 3D-sign - Added functionality to make 3D-sign in AutoCAD (#HAN-671)
NEW: General - Added support for Ribbon menu (#HAN-701)
IMPROVED: General - Added support for greyscale in “display mode” (#HAN-702)
FIXED: 612 - Area was not always calculated correctly (#HAN-679)

Norwegian version
●

●

FIXED: 3D-sign - The pick elevation from task was not stable (#HAN-784)
FIXED: 3D-sign - Updated height on the template “Foundation_C60mm_H500mm.dwg” (#HAN-819)

Swedish version
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FIXED: 3D-sign - The pick elevation from task was not stable (#HAN-784)
FIXED: B8 - Std. size is updated (#HAN-779)
FIXED: F5 - Horisontal location of text was not correct in all cases (#HAN-759)

Updates in Novapoint Road Marking
All versions
●

IMPROVED: General - Drawing rule for road marking added to “Default” (#HAN-832)

Update QuadriDCM Easy Access
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